Simple steps to improve accessibility of word documents used in public and patient involvement

About this document
In this document we use comments to highlight the simple steps we used to increase the accessibility and screen-reader readiness of a PPI Ignite Network @ UCD document. We have created this document to share with others how simple changes can make significant differences to document accessibility. 
Our goal is that sharing the steps we took will enable others to also make their own documents more accessible.
There are 10 comments. Each comment includes a brief description of:
What we did to improve accessibility,
How we did it in Microsoft word,
Why doing this is important for accessibility.  

Note:
If the comments bar is not automatically visible when you open this document, please go the Review tab, Comments section on the ribbon, and click “Show Comments”. 
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[bookmark: _Toc171597789]About this template	Comment by Emma Dorris: What: Use of inbuilt styles (e.g. Heading 1, Heading 2)  to give the document structure.

How: Use the Styles function on the ribbon in the Home Tab.

Why: Screen readers use this to navigate through the document. 
It also aids in the creating the table of contents.
Please use this template as a guide only. The expectations of engagement for different voluntary and community based organisations may differ.  Each organisation should develop and adapt the format and content according to their needs and context. Please read each section carefully. Not all sections or content will be applicable to your organisation and will require adaptation. 	Comment by Emma Dorris: What: Use of a simple easy to read font without decorative elements.

How: Home tab, under the font section on the ribbon, select a font like Arial or Calibri. Proxima Nova is commonly used for digital documents.

Why: Simpler typefaces are easier to read as there is a clear separation between the foreground and background. This makes the characters easier to tell apart for people with vision or reading impairments.
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[bookmark: _5x0d5h95i329]Organisation Name
[bookmark: _af80tl7prv5v]Expectations of Engagement Version X.X, Date: 4th September 20XX
[bookmark: _uqugw7uwdw61][bookmark: _Toc171597790]Purpose 
Sample text	Comment by Emma Dorris: What: Use of strong colour contrast.

How: Highlight word, go to Review tab, click Check Accessibility. This will tell you if contrast is too low and give tips to fix it.

Why: Sufficient contrast between the text and background colours improves readability for people with vision impairments.
By requesting our help to reach the community we serve, you are entering into a PPI relationship not just with those community members but also with us as an organisation. We have certain expectations of PPI collaborations we enter into. We also want to be clear about what you should, and should not, expect from our organisation. By submitting your PPI request, you agree to act in accordance with these expectations. Failure to meet these agreed expectations could result in the termination of this or future collaborations. 	Comment by Emma Dorris: What: Use of a minimum font size of 12.

How: Highlight text, home tab, font section on ribbon, select font size.

Why: Makes documents easier to read for people with vision and reading impairments.
[bookmark: _exfjgdm1gduj][bookmark: _Toc171597791]Overall principles of the organisation
Include the values and principles of your organisation. State that you expect the research and researchers to align with these. 	Comment by Emma Dorris: What: Spacing of at least 1.5.

How: Home tab, paragraph section on the ribbon, select line and spacing button.

Why: People with dyslexia may merge or distort text when reading. Increasing the white space between sentences and paragraphs can help to reduce the reading load.
[bookmark: _39wkguwyjrtp][bookmark: _Toc171597792]Statement on what researchers can expect from our organisation when seeking PPI introductions.
This section should clearly outline whether you have dedicated resources, processes, or other commitments to PPI as an organisation, and what you can/are willing to provide for the PPI relationship.
Sample Text
Remember- suggestions only, not all will be applicable to your organisation. Adapt as necessary.	Comment by Emma Dorris: What: Limited use of bold or italics. Use only as part of emphasis to identify important information.

How: Avoid excessive use of italics, bold, or all uppercase letters. 

Why: Can be difficult for people with vision impairments of dyslexia to read, especially when used for large amounts of text.
XXX as an organisation is supportive of PPI in research. However, we are limited in our ability to give dedicated time, support and resources to every request related to PPI we receive from researchers. We have our own research agenda and may prioritise PPI requests based on a number of factors, including impact for our community and alignment with our organisation’s goals.
XXX Organisation supports PPI in the following ways:
· we have a remit to support research;	Comment by Emma Dorris: What: Use of inbuilt bullets or numbering to create lists.

How: Highlight text, select the bullet button from the ribbon in the Home tab. 

Why: Use of the inbuilt bullet/numbering function identifies the text as part of lists on screen readers.
· we have a remit to support PPI in research;
· we have in-organisation knowledge and expertise of the needs of the community we serve;
· we have expertise and knowledge in how best to support the community we serve;
· we have a staff member/volunteer with a remit to support PPI in research;
· we have staff/volunteers who are trained in PPI;  
· where appropriate, we can connect the community we serve with researchers for PPI in a standard/ad hoc fashion [you can list any terms under which you do this];
· to obtain prior approval for any future PPI relationships with members of our community that you were introduced to via our organisation, including for different projects;
· where appropriate, we disseminate advertisements for relevant PPI opportunities via our communication channels;
· we maintain and support our own PPI panel [you can list terms of access];
· we provide funding for PPI in research;
· we provide training for PPI to the community we serve.

XXX Organisation are typically unable to support PPI in the following ways:
· we do not provide stand-alone funding for PPI in research;
· we do not have dedicated staff/volunteers for PPI in research. While efforts are made to respond to PPI requests in a timely fashion, they are not given priority as they are outside the core remit of our organisation; 
· we do not act as a service to pass on PPI opportunities to the community we serve; 
· we are unable to facilitate PPI requests that require turn-around time of less than XX weeks.
[bookmark: _haqkikr3lwpp][bookmark: _Toc171597793]Statement on what is expected from researchers seeking PPI introductions.
This section should clearly outline what you expect as standard from researchers engaging your organisation. 
Sample text
Researchers will:
· be respectful of the responsibilities, viewpoints and expertise of this organisation and the community we serve;
· be flexible in their ways of working to accommodate the needs of this organisation and the community we serve;
· carry out PPI to the highest ethical and good practice standards;
· uphold the PPI Ignite Network Values and Principles of PPI; 	Comment by Emma Dorris: What: use of hyperlinks with descriptions for links.

How: Highlight text, go to Insert tab, click Link, add description in the “Text to display field” and the URL in the “Address” field.

Why: Screen readers will read out every character of a URL, so avoid typing full URLs in texts. 
People who use screen readers can scan a list of links. If all links are called something generic like “click here” they can’t be distinguished. Therefore links should convey clear and accurate information about the destination.  
· ensure availability of suitable, clearly defined resources and competencies for successful PPI;
· respect any requests for confidentiality;
· declare any conflicts of interest if they arise and inform this organisation of such in a timely fashion;
· ensure that any researchers engaged in PPI are appropriately skilled and supported to do so [You can outline any specific skills you believe necessary here];
· establish and implement a communication plan to ensure both this organisation and the community we serve are kept informed of progress on the research throughout the entire research lifecycle.
[bookmark: _hnskav2ofdpt][bookmark: _Toc171597794]Communication
[bookmark: _wrtpd5j36kp0]This section is used to outline what communication your organisation expects from the researchers. Include any expectations of accessibility, expected follow up from researchers, and what you expect in terms of short-, mid-, and longer-term communications.
[bookmark: _6i57cby63vw9]Sample text
[bookmark: _qkarus4l4ha]We as an organisation expect to be kept informed of the research project that involves us or the community we serve. 
[bookmark: _7h6jnie4xl6t]We expect:
· [bookmark: _ph4w0lrln2k2]researchers agree to a communications plan that includes the frequency and means of update communications;
· [bookmark: _v3r5gy47ybxt]communications to be conducted in plain English;
· [bookmark: _4kyi4mfqf6i7]communications to be provided in accessible formats [list any specific accessibility needs here];
· [bookmark: _l1va9v2s91cn]to be updated about PPI relationships between you and the community we serve. 
[bookmark: _lziixsz5rjcb][bookmark: _Toc171597795]Conflict management
Use this section to outline the steps you expect researchers to take/researchers should expect from you in relation to any arising conflicts.
Sample text
Conflicts may arise between stakeholders involved in PPI relationships. As an organisation who serves our community, we can be negatively impacted by these conflicts. We need to be kept informed of any arising issues in relationships facilitated through us. 
We expect:
· to be informed in a timely manner if any conflict arises between researchers and PPI contributors engaged through our organisation;
· that you have a transparent policy or procedure in place to manage stakeholder conflict upon entering a PPI relationship;
· engagement with us to co-develop mutually agreed mitigation strategies and documentation processes to deal with any arising issues;
· to be aware of where you can access or undertake conflict resolution training and/or processes.
[bookmark: _elr3c3dlq69][bookmark: _Toc171597796]Raising concerns
Use this section to outline if you have any procedures for raising concerns, or if you expect researchers to have policies or procedures for the same.
Sample text
If researchers have concerns:
· please raise concerns at the earliest opportunity to the organisation via email [include if you have standard steps- you may have some transferable steps you use for volunteers]
· Include what the issue is;
· How long it has been on-going;
· What steps have been taken to resolve it and their outcome;
· Preferred follow-up (phone call/email). 
Similarly, the organisation or PPI contributors may wish to raise concerns:
· We expect you to have a transparent policy or process to raise concerns.
· We expect this to be provided to both the organisation and the PPI contributors engaged through us upon entering a PPI relationship.
[bookmark: _he96il2dcdm7][bookmark: _Toc171597797]Payments and Reimbursement  
Use this section to outline your policy on payments and reimbursement related to PPI. This can include expectations of payment of PPI contributors engaged via your organisation, but also any expectations the organisation has in terms of receiving a portion for the research grant funding.
Sample text
We consider remuneration to be best practice for PPI. At a minimum we expect research project leads to ensure timely reimbursement of travel expenses, out of pocket expenses, and subsistence related to PPI in their research. We also expect:
· Transparency of expenses process
· Transparency of remuneration and process of remuneration
· Timely remuneration
Please note that the organisation will not take responsibility for administering payments or expenses. 
As an organisation, it takes time and resources to engage with researchers for PPI. If you are applying for grant funding for your research project, we expect you to include a budget line to compensate the organisation for the time, resources, and expertise we lend to your project.
We expect you to engage with us during the funding proposal budget development and to determine a suitable payment/reimbursement plan should grant applications be successful.
[bookmark: _x5o27v8ypnz2][bookmark: _Toc171597798]Confidentiality
Confidential information includes all non-public information, written or oral, disclosed or made available directly or indirectly, by or on behalf of, one party through any means of communication or observation. This can include an organisation's planned campaign or strategy, and information shared by PPI contributors in addition to sensitive research information. It is good to be clear about expectations if you anticipate the need for confidentiality in your engagement with researchers.
Sample text
We expect researchers to maintain organisational confidentiality, and confidentiality of the community we serve. In turn you can expect us to uphold reasonable requests for confidentiality.
To achieve this, we both agree to and expect:
· labelling of confidentiality level of information [including being explicit about whether information shared in meetings can be shared beyond the meeting];
· if no clarification or labelling is made by the disclosing party, the information will be presumed to be public/if no clarification or labelling is made by the disclosing party, the information will be presumed to be confidential [select as appropriate for your organisation];
· any disclosure of confidential information to third parties requires prior consent of the owner;
· deletion of confidential information whenever the disclosing party requires it, and upon request, confirm the deletion to the other party.
[bookmark: _8rzl94ih5bgw][bookmark: _Toc171597799]Data protection and data ownership
Data protection controls how personal information is used by the researcher and the patient organisation. Data protection should ensure that all data, or information, relating to individuals collected in surveys, meetings, or communications, are used for limited, specifically stated purposes, and in a way that is adequate, relevant and not excessive.
In this section you can include the controls you have and expect the researchers to have to safeguard information about individuals and their privacy. 
Sample text
We have our own data protection policy which can be found here [insert link].
We expect researchers to be clear and transparent regarding how they will use any information we or the community that we serve provide. All researchers must abide by the data protection requirements legally required via GDPR and Irish national legislation. 
Information gained from us or the community we serve through the PPI process remains under the ownership of the individual knowledge holder. 
[bookmark: _ia7fm2f04k7h][bookmark: _Toc171597800]Intellectual property
Intellectual property (IP) refers to the protection of creations of the mind. These creations may have a moral, social and/or a commercial value. IP enables people or organisations to gain recognition, added value or improved services from their ideas or creations. 
Agreements on IP can be important to discuss upfront because it outlines who can further develop the topic independently after the collaboration, based on the collaboration and any ideas generated through it. 
Sample text
Background IP remains with the owner. Each party will retain exclusive interest in, and ownership of its IP developed before this collaboration or developed outside the scope of this collaboration.
We expect researchers to provide information on IP and be transparent in relation to expectations and ownership. We expect ownership to remain with the producing partner (be that this organisation, the PPI contributor, or the researcher) except in cases where parties have explicitly and in writing agreed otherwise in respect to the collaboration. 
Researchers are not authorised to use the name(s) and/or logo(s) of this organisation without our prior written consent.
[bookmark: _svibpbpllauu][bookmark: _Toc171597801]Indemnity
Indemnity is the obligation of one party to compensate for the loss incurred by another party. It is the basis of insurance. Indemnification clauses seek to define financial responsibility for specific types of damages, claims or losses. In practice such situations are likely to be rare, but in extreme cases they may arise. You may therefore wish to outline if your organisation has liability insurance, if your liability insurance extends to community members, or if the researchers are expected to assume liability for PPI contributors.
Sample text
· We expect all researchers to have liability insurance for their research.
· This organisation does not assume liability for any members of the community we serve that you engage for PPI through us. 
· This Organisation’s total liability whatsoever and howsoever arising in connection with this collaboration shall be limited to one Euro (€1).
Expectation of Outputs 
This section is used to outline if you require any special outputs, or specific versions of research outputs. 
Sample text
In addition to academic output, we expect:
· plain English versions of all outputs to be provided to our organisation;
· plain English updates of the research for public dissemination via our organisation’s communication channels;
· support/Training/Shared learning for PPI contributors.
[bookmark: _e7ik6dulbde0][bookmark: _Toc171597802]Acknowledgement of the organisation
In addition to any PPI contributors engaged through our organisation, we expect the contribution of the organisation to be acknowledged appropriately on any outputs, presentations or other material associated with the PPI aspect of this research. 
Prior to acknowledgement both partners should review and agree content of any work or material on which they are to be acknowledged. 
We reserve the right to include a “views expressed disclaimer” without the need for justification on any research output arising from this collaboration. For example, “Content does not reflect the opinions and beliefs of the Organisation or its affiliates.”
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[bookmark: _vi8jd4tahv9t][bookmark: _Toc171597803]Development of this template
[image: The PPI Ignite Network Logo. It has an icon with three people surrounded by a dark blue circle. PPI Ignite Network is written below the Icon.]  [image: University College Dublin Logo. It is shield shaped with a band of blue at the top featuring the icon of three castles, a band of dark blue in the middle with the words UCD Dublin in white, and a band of green at the bottom featuring a golden harp.]   [image: The Family Carers Ireland Logo. It is blue with a white background. There is a blue icon to the left of two hands holding up a heart. Text on the right is stacked and reads Family Carers Ireland. Below the icon and text is the tag line "No one should have to care alone".]  [image: The Muscular Dystrophy Ireland Logo. It is rectangular in shape and has a upper white half with an orange icon of a stylised upper body and head. The lower half if dark green with "MDI Muscular Dystrophy Ireland" stacked in white.] [image: Health Research Charities Logo on a white background. HRCI is written in Green with the "C" a lighter shade. Above this are coloured loops that link the "H" to each of the other letters. Below is "Heath Research Charities Ireland" with "charities" in a lighter shade of green.]	Comment by Emma Dorris: What: Addition of Alt Text to images.

How: Right click image, select “View Alt Text”, add description to pop up box.

Why: Information that is visually conveyed in the image becomes accessible to those with visual impairments. Screen readers can read image alt text.  
This template was co-developed by:
	Author (Listed alphabetically) 
	Affiliation 

	Sarah Delaney
	Health Research Charities Ireland

	Emma Dorris
	University College Dublin
PPI Ignite Network @ UCD

	Nikki Dunne
	Family Carers Ireland

	Dylan Keegan
	University College Dublin

	Dympna Mulroy
	Muscular Dystrophy Ireland

	Joanne Murphy
	Family Carers Ireland

	
	


The production of this template was driven by a need identified at a collaborative workshop with input from Emma Dorris, David Bennet and Thilo Kroll  (University College Dublin, facilitators), Ciara O'Reilly (Alzheimer Society of Ireland), Andrea Eakin and Gráinne Hickey (Barnardos), Zoe Hughes (Care Alliance Ireland), Joanne Murphy (Family Carers Ireland), Rachel Bermingham (Fighting Blindness), Sarah Delaney (Health Research Charities Ireland), Dympna Mulroy (Muscular Dystrophy Ireland), Bibiana Savin (Sage Advocacy) and Daire Dempsey (Transgender Equality Network of Ireland (TENI)). 
We would like to acknowledge Teerna Banerjee for her administrative assistance.
PARADIGM IMI Patient Engagement toolbox resources informed aspects of this template. 

Use of this template
[image: Grey and black logo for the Creative Commons Attribution-Non-commercial 4.0 International License. It includes three icons. 
1. the creative commons icon which is a black circle around "CC". 
2. The attribution icon which is a person in a black circle, below the this icon is "BY". 
3. A circle with a dollar sign and a line through it. beneath this icon is "NC" ]
This work is licensed under a Creative Commons Attribution-Non-commercial 4.0 International License.
We encourage the use and adaptation of this document under the terms of the CC-BY-NC licence.
To meet the terms of the CC-BY-NC licence, non-commercial users of this template can simply add “This document is adapted from Dorris E, Delaney S, Dunne N, Keegan D, Mulroy D, and Murphy J (2023). Expectations of Engagement Template document for PPI relationships. Figshare. Online resource. http://doi.org/10.6084/m9.figshare.24026442” at the end of your document.
Template DOI: 10.6084/m9.figshare.24026442
Correct Citation: Dorris E, Delaney S, Dunne N, Keegan D, Mulroy D, and Murphy J (2023). Expectations of Engagement Template document for PPI relationships. Figshare. Online resource. http://doi.org/10.6084/m9.figshare.24026442

Funding 
This work was funded by the Health Research Board (HRB) and the Irish Research Council (IRC) and University College Dublin.
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